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Comparative analysis of estimation of slope-length
gradient (LS) factor for entire Afghanistan

Ahmad Ansaria,b and G€okmen Tayfurb

aDepartment of Water Resources and Environmental Engineering, Helmand Higher Education
Institute, Lashkar Gah City, Afghanistan; bDepartment of Civil Engineering, Izmir Institute of
Technology, Izmir, Turkey

ABSTRACT
Slope length gradient (LS) is one of the crucial factors in the
Universal Soil Loss Equations (USLE, RUSLE). This study aimed at
estimating the slope-length and slope-steepness (LS) factor for
the entire watersheds of Afghanistan by using three different
methods, namely; (1) LS-TOOLMFD (Method 1); (2) The Method of
Equations (Method 2); and (3) The approach of Moore and Burch
(Method 3). The first method uses the digital elevation model
(DEM) in the ASCII format, and the other two methods use the
DEM in the spatial domain. The results show that the LS-factor of
the study area ranges from 0.01 to 44.31, with a mean of 5.24
and standard deviation of 6.95, according to Method 1; 0.03 to
163.49, with a mean of 9.6 and standard deviation of 13.58,
according to Method 2; and 0 to 3985, with a mean of 7.16 and
standard deviation of 29.7, according to Method 3. The study
reveals that Methods 1 and 2 are more appropriate than Method
3 because Method 3 yields high LS-factor values close to or at
streamlines located near mountainous regions. The highest LS val-
ues are found to be in the northeast, north, and central regions
of Afghanistan, which is consistent with the high mountains and
deep valley geomorphology, indicating that these regions are par-
ticularly vulnerable to soil erosion by rainfall-runoff processes. The
sediment delivery ratio (SDR) for the Upper-Helmand River Basin
(Upper-HRB) is also estimated by the RUSLE, employing the LS
factors produced by the three methods. The results revealed that
the average annual soil loss is found to be, respectively, 9.3, 18.2,
and 11.1 (ton/ha/year) by using the three methods, corresponding
to SDR of 23.5%, 12.1%, and 19.9%.
Abbreviations: ABD: Asian Development Bank; ASCII: American
Standard Code for Information Interchange; Bsh: cold semiarid
steppes; Bsk: cold semiarid steppes; Bwh: warm and cold deserts;
Bwk: warm and cold deserts; CMS: Convention on Migratory
Species; Csa: humid subtropical; Csb: Mediterranean; D: humid
continental; DEM: Digital Elevation Model; ET: extreme tundra;
GCS: Geographical Coordinate System; GIS: Geographic
Information System; GUI: Graphically User Interface; Ha: Hectare;
HMRB: Harirod-Murghab River Basin; HRB: Helmand River Basin;
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KRB: Kabul River Basin; LS: Slope–Length and Slope–Steepness;
Masl: meters above sea level; MFD: Multiple-Flow Direction; NRB:
Northern River Basin; PARB: Panj-Amu Darya River Basin; RUSLE:
Revised Universal Soil Loss Equations; SDR: Sediment Delivery
Ratio; SFD: Single–Flow Direction; SRTM: Shuttle Radar
Topography Mission; SY: Sediment Yield; UCA: Unit Contributing
Area; USGS: United States Geological-Survey; USLE: Universal Soil
Loss Equations

1. Introduction

Soil erosion process and sediment transport by rainfall-runoff are frequently cited as
the most severe kinds of land degradation with significant environmental and socio-
economic consequences (Fu et al. 2006; Rahman et al. 2009; Aiello et al. 2015; Phinzi
and Ngetar 2019; Xiao et al. 2021). Agricultural and livestock production provides
about 95% of the world’s food, making the soil a critical resource for feeding a grow-
ing population (FAO 2015). The most recent United Nations report on the situation
of the world’s soil resources emphasizes that ‘the majority of the world’s soil resour-
ces are in just fair, poor, or very poor situation’ and highlights that the ‘soil loss, ero-
sion and sediment transportation continue to pose a significant agricultural and
environmental threat all over the world’ (FAO and ITPS 2015). Developing countries,
particularly Malaysia, Indonesia, Iran, Turkey, and India are currently dealing with a
significant soil erosion problem primarily caused by rainfall intensity, raindrop
energy, and topographic and anthropogenic characteristics (Morgan 1974; Demirci
and Karaburun 2012; Markose and Jayappa 2016; Noori et al. 2016; Kashiwar et al.
2022). Several studies have also cited human activity as the key source of current
land use and cover changes (Oldeman et al. 1990; Bridges and Oldeman 1999; J.
Thomas et al. 2018; Kashiwar et al. 2022; Villarreal et al. 2022).

Slope-length (L) and steepness (S) are two topographic parameters, used in the
USLE and RUSLE, contributing to soil erosion. The topographical effects of soil ero-
sion are depicted by the combined effect of slope-length and slope-steepness (LS).
The volume and rate of cumulative runoff increase as the length of the land slope
becomes steep. Additionally, when the slope increases, the runoff velocity also
increases, contributing to soil erosion (Ghosal and Das Bhattacharya 2020; Xiao et al.
2021). The topographic factor LS and soil erosion have a direct relationship; erosion
by runoff would be high when slope length and slope steepness are high and vice-
versa (Gupta and Kumar 2017; Kashiwar et al. 2022; Kulimushi, Maniragaba, et al.
2021). It indicates the influence of slope-length and steepness on sheet, rill, and inter-
rill erosion by water. Ganasri and Ramesh (2016) and Kashiwar et al. (2022) state
that the LS-factor represents its impact on soil loss over a watershed area. The LS-fac-
tor in the RUSLE model accounts for the influence of flow accumulated in cells
upstream to those downstream (Wischmeier and Smith 1978; Rubianca et al. 2018;
Elnashar et al. 2021), representing soil loss ratio under given conditions to that area
with a slope-length of (L¼ 22.12m) and slope-steepness of 9% (Renard et al. 1997).
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The factor is the ratio of anticipated soil erosion from a field’s slope gradient to the
actual USLE unit plot length (Wischmeier and Smith 1978).

The topographic factors (L and S) were in one dimension when the USLE and the
RUSLE were initially developed for gentle-sloping fields. However, to estimate the
average annual rill and sheet soil erosion per unit area at country-level river basins,
the topography becomes 2D, and the calculation of the LS factor becomes more com-
plex than other variables in the USLE and RUSLE (Ligonja and Shrestha 2015; Zhang
et al. 2017). The researchers can account for more topographically complicated ter-
rain by using the digital elevation models (DEMs) to compute flow accumulation, cell
size, upslope draining regions, and corresponding LS-factor (Moore and Burch 1986;
Desmet and Govers 1996; Rubianca et al. 2018; Kulimushi, Choudhari, et al. 2021).

The USLE and the RUSLE are commonly used to predict soil erosion at regional
levels; nevertheless, a fundamental limitation is the difficulty of obtaining the LS fac-
tor (Zhang et al. 2017). Several adjustments have been made to the original LS factor
model proposed by Wischmeier and Smith (1978) (Table 1). According to McCool
et al. (1989), soil loss increases on slopes that are steeper than 9% (Panagos et al.
2015; Kruk et al. 2020). Using the point approach of Griffin et al. (1988) for the L
factor and Moore and Wilson (1992) for the S factor, Moore and Wilson (1992) pro-
posed the unit contributing area (UCA) method in a simple equation to estimate LS
for three-dimensional topography. The technique developed by Desmet and Govers
(1996), based on raster resolution and unit area, are widely used by researchers all
around the globe. Panagos et al. (2015) suggested a novel methodology based on the
UCA method to determine topographic parameters in regions comparable in size to
European countries and examined the effect of DEM resolution on the distribution of

Table 1. Formulas and methods for calculating the topographic factor (LS).
Equation Reference Description

LS ¼ k
22:13

� �m
ð65:4 sin2bþ 4:5 sin bþ 0:0654Þ Wischmeier and Smith

(1978)
where k is the slope length in

(meters) and m is equivalent to
0.5 for slopes steeper than 5%,
0.4 for slopes between 3 and 4%,
0.3 for slopes between 1 and 3%
and 0.2 for slopes less than 1%

L ¼ k
22:13

� �m
,m ¼ b

1þb

� �
, b ¼ sinh

0:0896

3 ðsinhÞ0:8þ 0:56

� �
McCool et al. (1989) where L is the slope length

coefficient; 22.13 is RUSLE plot
length (meters); b ¼ ratio of rill
to inter-rill erosion, and h ¼
slope angle

LS ¼ As
22:13

� �m
sinh

0:0896

� �n
Moore and Wilson

(1992)
where As is a specific catchment

area (m2/m), h is the slope angle
in digree, m is between:
0.4� 0.56; and n is between 1.2
and 1.3

L ¼ ðmþ 1Þ � As
22:13

� �m
, S ¼ sinb

0:0896

� �
n Griffin et al. (1988) where L, S, m, As same as above,

m¼ 0.4 (range: 0.2–0.6);
and n¼ 1.3 (range: 1.0–1.3)

Lði:jÞ ¼
ðAði, jÞþD2Þmþ1�Amþ1

ði, jÞ
xmði, jÞ Dmþ 2 �ð22:13Þm

� �
Desmet and Govers

(1996)
where A(i,j) is the contributing area

at the inlet of grid cell (i.j)
measured in m2, D is the grid cell
size (meters), x ¼ sin ai,j þ cos
ai,j, the ai,j is the aspect direction
of the grid cell (i,j)

(LS-TOOLMFD) Zhang et al. (2017) LS factor calculator tool
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the LS factor (Kruk et al. 2020). L can be estimated using the UCA or the slope
length (k) as input parameters for large watersheds. The UCA approach is inad-
equately accurate due to the lack of a slope length estimation. The spatial accuracy of
slope length and the LS factor must be improved to predict soil erosion accurately
(Zhang and Wang 2017). To overcome these limitations, Zhang et al. (2017) proposed
an improved approach to calculated the slope length and LS factor. To determine the
slope length (k) and the LS factor, they integrated the multiple-flow direction
algorithm (MFD), used in the UCA technique with the LS-TOOL (LS-TOOLSFD)
algorithms, accounting for calculation errors and distance cutoff conditions. The
(LS-TOOLMFD) approach was implemented and validated in a watershed with com-
plexly changing slopes. The slope length and LS estimated using (LS-TOOLMFD)
agreed with field data better than the (LS-TOOLSFD) and UCA techniques.

The methodology for determining the LS factor by the USLE or the RUSLE
employs slope- length, angle, and a parameter that is proportional to the slope’s-
steepness in percent (Wischmeier and Smith 1978). Several approaches have been
developed over the last two decades that enable the application of the ArcGIS plat-
form to develop verified algorithms for calculating the LS-factor that are both USLE-
and RUSLE-based (Khosrokhani and Pradhan 2014; Zhang et al. 2017; Lanorte et al.
2019; Pal and Chakrabortty 2019b; Chakrabortty et al. 2022; Das et al. 2022; Kaffas
et al. 2021). According to Zhang et al. (2017), using the LS-TOOLMFD is more realis-
tic and easy to determine LS-factor values in large watersheds, while the approach of
(Moore and Burch 1986) (Method 3) also has advantages over the original LS-factor
equations proposed by Wischmeier and Smith (1978), in which they had applied a
particular contribution area as a slope length estimate, which is more suitable to 3D
landscapes. Das et al. (2022) used the two methods combined with the GIS procedure
to estimate the LS-factor. Such approaches employing several methods are key
improvements in estimating the LS-factor for large regions such as Afghanistan.

The topographic factors (L and S) were in one dimension when the USLE and the
RUSLE were initially developed for gentle-sloping fields. However, to estimate the
average annual rill and sheet soil erosion per unit area at country-level river basins,
the topography becomes 2D, and the calculation of the LS factor becomes more com-
plex than other variables in the USLE or RUSLE equation (Ligonja and Shrestha
2015; Zhang et al. 2017). The researchers can account for more topographically com-
plicated terrain by using the DEMs to compute flow accumulation, cell size, upslope
draining regions, and corresponding LS-factor (Moore and Burch 1986; Desmet and
Govers 1996; Rubianca et al. 2018; Kulimushi, Choudhari, et al. 2021).

It is impossible to obtain an exact estimate of how much of Afghanistan’s land sur-
face is affected by the soil erosion problem, due to the absence of sufficient soil infor-
mation. Soil mapping in Afghanistan has only been done on a minor scale, and
detailed study is limited to alluvial valleys-little is known about the country’s upland
soils. However, due to the geography of the region, the dry environment, and the des-
ert character of the study area, approximately 80% of it might be exposed to soil loss
by water. The topography in Afghanistan’s mountainous regions has been severely
folded by tectonic activity, resulting in steeper slopes and deep valleys (Tapponnier
et al. 1981). Additionally, to study on a country level, specifically in developing and
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under-developing countries, in particular, the lack of field measurement and data due
to complex topography, the danger of land mines, and the region’s instability (special
case in Afghanistan), and social, political, and economic constraints results in less
data and necessitates the use of cost-effective spatial techniques prior to field assess-
ment (Sujatha and Sridhar 2018). The loess soil is characterized by will-formed hori-
zontal fractures and susceptible soil erosion. Additionally, several factors contribute
to soil loss in Afghanistan: poor land use practices, such as cultivating crops on open
land or reclaiming steep slopes, as well as an over-reliance on shrubs for fuelwood,
all contribute to severe soil loss in Afghanistan (Saba 2001).

A careful review of the literature reveals that no substantial research has been
undertaken on the importance of quantifying the LS-factor in the study area and its
impact on sustainability in Afghanistan, containing steep slopes in the central, north,
and northeast regions. The objectives of this study are mainly three folds: (1) to esti-
mate the LS-factor for the entire watersheds in Afghanistan by three widely used LS
methods, namely; the LS-TOOLMFD (Method 1), the Method of Equations (Method
2), and the approach of Moore and Burch (1986) (Method 3); (2) to compare the
output of three different methods with studies carried out in similar topography with
similar approaches and objectives; and (3) to assess the characteristics of the topo-
graphic factors and determine the most appropriate model for the LS-factor estima-
tion, which would help researchers to estimate soil loss and prepare risk assessment
maps and management plans for watersheds of Afghanistan.

Figure 1. Locations of Afghanistan’s five major River Basins map, meteorological station, Kajaki
Reservoir, Lakes, and inland water.
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2. Description of the study area

Afghanistan has a varied geography and is located in the Central Asian region. It is
bounded by Turkmenistan, Uzbekistan, and Tajikistan in the north; China in the
northeast; Pakistan to the east and south; and Iran to the west. It lies between 29� 350

and 38� 400 north latitude, and 60� 310 and 74� 550 east longitude (Shrestha 2007).
The mountains cover the majority of the country’s land area, where the elevation
ranges from nearly 248 m at the lowest altitude in the northern valley of the Amu
Darya River to the highest, at 7435 m above sea level (masl) in the mountainous
regions. The study area covers all five major river basins and 41 sub-basins in
Afghanistan, surrounding a total area of about 647,500 km2 that corresponds to
Helmand River Basin (HRB), Harirod-Murghab River Basin (HMRB), Northern River
Basin (NRB), Panj-Amu Darya River Basin (PARB), and Kabul River Basin (KRB)
(see Figure 1).

Figure 2 shows the climate map for Afghanistan. According to K€oppen-Geiger’s
climate type classification, Afghanistan is classified as cold and warm semi-arid
steppes (Bsh, Bsk, see Figure 2), and cold and warm flat deserts (Bwh, Bwk, see
Figure 2). The warmer deserts are located in southwest Sistan Catchment, while the
warmer steppes are situated in the Jelal Abaad Catchment and the east side of
Rigestan. The cooler steppes and flat lands are seen in the north regions of
Afghanistan. The Mediterranean (Csb, see Figure 2) and humid sub-tropical (Csa, see
Figure 2) climates occur at lower altitudes in the north and south. These climates are

Figure 2. Detailed climate map of Afghanistan (Bsh, Bsk: cold semiarid steppes; Bwh, Bwk: warm
and cold deserts; Csa: humid subtropical; Csb: Mediterranean; D: humid continental; ET: extreme
tundra) (Source: De Bie et al. 2007; Shroder 2014).
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characterized by mild winters and dry summers, while the humid continental climates
(D, see Figure 2) vary from warmer to cooler and colder, which depends on altitudes
from lower to higher elevations. The Cold climates, such as the extreme tundra (ET,
see Figure 2) and ice caps, can be found at the highest mountain peaks (Koppen
1936; De Bie et al. 2007; Shroder 2014).

Soil erosion by water is a natural process whereby soil particles are detached by
the splash when the raindrop hits the land surface. The detached particles are trans-
ported to the rills by overland flow, and the process is called inter-rill erosion
(Thorman 2007; Yang 2014). The five dominant process of soil erosion in
Afghanistan is classified as (Hillslope, gully, stream bank, landslide, and Deflation).
The most common type of water erosion in Afghanistan’s topography is hillslope ero-
sion, which includes sheet and rill erosion. This type of water erosion lowers land
productivity because it removes fertile topsoil, which contains the majority of the
soil’s plant nutrients and microorganisms that help keep the soil healthy (Saba 2001;
Shroder 2014; John and Sher Jan 2016). Sheet and rill erosion is also a significant
contributor to sedimentation and deterioration of water quality in rivers, ponds, and
reservoirs, and it could contribute to the loss of �50% of dams’ storage capacity, spe-
cifically the Kajaki and Dahla dams, which lost about �42% and �40% of their water
storage due to sedimentation, respectively (Orville et al. 1976; US Army Corps of
Engineers 2012; US Army Corps 2014; ADB et al. 2019).

3. Materials and methods

In this study, for the LS calculations, three methods were employed. The aim of using
three methods for LS calculation was to obtain the appropriate method for
Afghanistan. In all these methods, the DEM was first employed to generate the LS
factor maps.

An SRTM-DEM raster image was used to calculate the slope-length and slope-
steepness factor (LS). Approximately one hundred and two (102) SRTM 1 Arc-
Second (30m spatial resolution) raster tiles were downloaded for the entire
Afghanistan region from the United States Geological-Survey (USGS) earth-explorer
tool (https.://earthexplorer.usgs.gov./). The DEM raster tiles were imported from Add
Data command to the ArcGIS environment as an input. For further data processing
and mosaicking of the DEM for Afghanistan from raster tiles, the ArcGIS
Toolbox>Data Management-Tools>Raster-Tool>Raster-dataset>Mosaic to New
Raster processing steps were used in ArcGIS version 10.7.1 software (Izmir Institute
of Technology, Turkey.). For extracting the DEM file for Afghanistan from mosaicked
tiles, the Arc Toolbox> Spatial Analyst-Tools>Extraction-Tool>Extract by mask
processes were followed to clip the desired region in ArcGIS 10.7.1 platform. For the
projection of DEM file of entire Afghanistan, the Arc Toolbox>Data Management-
Tools> Projection and Transformation>Raster-Tool>Project raster steps were per-
formed to change the coordinate system from Geographical Coordinate System
(GCS) 1984 to Lambert Conformal Conic projection system in ArcGIS 10.7.1. The
final step was to convert the DEM raster format to ASCII format; the Arc
Toolbox>Conversion tools> From Raster>Raster to ASCII procedure was followed

GEOMATICS, NATURAL HAZARDS AND RISK 7



to convert the DEM raster format to ASCII format. The study area’s surface elevation

Figure 3. Digital elevation model (m) of Afghanistan.

Figure 4. Slope (%) map of Afghanistan.
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ranges from nearly 238 to 7461 m above sea level (masl) (see Figure 3). The slope
map of Afghanistan was derived in percentage and degree and classified based on the
recommendation of Lee (2014).

Figure 4 presents the generated slope map for the whole Afghanistan. The colours
of green and dark green represent relatively flat areas while red colour shows a rela-
tively steep slope (S> 15%). Slopes are classified into five slope classes as: very gentle
slope grade zone (less than 5%), gentle slope grade zone (5–15%), moderate slope
grade zone (15–30%), steep slope grade zone (30–50%), and very steep slope grade
zone (more than 50%) as per the recommendations in the literature (Berihun et al.
2020; Das et al. 2022; Negese et al. 2021). As seen in Figure 4, the high degree of
slopes is observed at high elevations.

The details of the three methods for calculating the LS factor are given in the fol-
lowing section.

3.1. LS-TOOLMFD (Method 1)

Zhang et al. (2017) presented a simple LS-TOOLMFD to estimate LS. The LS-TOOLMFD

algorithm saves processing time while improving the accuracy of large-scale erosion
modelling (Zhang et al. (2017). They found a strong correlation between the LS-factor
map estimated by LS-TOOLMFD and results collected from field data. Therefore, in this
study, the slope length and slope steepness factors (L and S, respectively) were estimated
using the LS-TOOLMFD method proposed by Zhang et al. (2017). For further processing

Figure 5. The graphical user interface of LS-TOOLMF.
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and sequences of LS calculation; the processed ASCII file was used as input data in Load
DEM>Output file path>Model (select; RUSLE) > Cutoff (select; Yes) > Sink Fill
(select; Yes) > Nodata Fill (select; Average) > Channel (select; YES) > Threshold Unit
(8000) > Cumulated way (select; Total) > Flow Direction (select; MFD) > Select MFD
(select; MS) > Save Database (select; LS factor) along with LS-TOOL calculator. Figure
5 depicts the graphically user interface (GUI) for the LS-TOOLMFD.

3.2. LS factor calculation using method of equations (Method 2)

In this method, the Shuttle Radar Topography Mission (SRTM) DEM obtained from
the United States Geological Survey (https://earthexplorer.usgs.gov/) and resampled to
250m spatial resolution was used to derive the L and S factors. For the LS factor cal-
culation and mapping, Equations (1)–(3) (Desmet and Govers 1996) and Equations
(4) and (5) (McCool et al. 1989; Renard et al. 1997) were employed.

Lfactor ¼ ðAþ D2Þmþ1 � Amþ1

Dmþ2 � 22:13m
(1)

m ¼ B
Bþ 1

(2)

B ¼
sin sl
0:0896

½0:56þ 3 � ðsin slÞ0:8� (3)

Sf actor ¼ 10:8�sin slþ 0:03, slopegradient in percent < 0:09 (4)

Sfactor ¼ 16:8�sin sl � 0:5, slopegradient in percent 	 0:09 (5)

where L represents the equivalent slope length factor for the cell, S is the slope steep-
ness factor, A is the contribution area at the inlet of the grid cell (m2); D is the size
of the grid cell (m); m represents the standard slope length exponent, B is the ratio
of rill to inter-rill erosion under the situations where the soil is fairly sensitive to the
both, sl is the slope in degree and to convert the angle (sl) from degree to radian,
0.01745 should be multiplied by sl.

L and S factor can be computed in the ArcGIS raster calculator using the map
algebra expression, expressed by the Equations (6)–(8), suggested by Chadli (2016)
and Elnashar et al. (2021) as follows:

L ¼ power flowaccumulationþ scale2ð Þ, M þ 1ð Þ
� �

�powerðflowaccumulation, M þ 1ð ÞÞ
power scale, M þ 2ð Þð Þ � pewerð22:13,M

�
(6)

S ¼ Con
�
Tan

�
slopex0:01745Þ < 0:09, 10:8xSin slopex0:01745ð Þ þ 0:03ð Þ (7)
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S ¼ ConðTan slopex0:01745ð Þ 	 0:09, 16:8xSin slopex0:01745ð Þ � 0:5ð Þ (8)

The value of slope in Equations (7) and (8) was obtained directly from a 250m
resolution DEM. Accordingly, the flow accumulation was generated from the DEM
after the filling and flow direction procedures in ArcGIS 10.7.1 are incorporated with
the Arc-Hydro extension tool.

3.3. LS calculation using approach of moor and Burch (1986) (Method 3)

Moore and Burch (1986) developed the LS estimation method using the DEM for
topographically complicated terrain, based on the unit stream theory. The method
requires the components such as flow accumulation and slope for computing L and S
factors. In this article, the slope-length and accumulation of flow were calculated
using the SRTM DEM in the Arc-hydro extension of ArcGIS software. The slope gra-
dient map was derived using the spatial analyst tool in the ArcGIS platform (Gupta
and Kumar 2017; Pal and Shit 2017). For extracting the study area from the DEM,
these sequences were followed in the GIS platform: ArcGIS 10.7.1> Spatial Analyst
Tools>Extract by mask. In the input raster command box, the DEM file was
selected, and in the feature mask data, the Shapefile of the study area was inserted
using the input raster or feature mask command (Jain and Das 2010; Gwapedza et al.
2018; Pal and Chakrabortty 2019b). Figure 6 illustrates the methodological flowchart,
employed in this study, for the computation of the LS factor using the method of
Moore and Burch (1986).

The accumulation of flow indicates an upstream region flowing into a particular cell by
accumulating the draining region of all upslope cells (Elnashar et al. 2021). For estimation
of the LS-factor in Method 3, maps, such as flow accumulation and slope (in degree) are
required. The SRTM-DEM raster file was used as an input image in the Arc Toolbox and

Figure 6. LS-factor calculation flowchart.
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Figure 7. Flow accumulation of the study region.

Figure 8. Slope (degree) map of Afghanistan.
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the processing sequences of Spatial Analyst tools>Hydrology> Fill> Flow
Direction> Flow Accumulation were followed in the ArcGIS 10.7.1 environment to com-
pute the flow accumulation map, shown in Figure 7. The areas with very low flow accu-
mulation are represented in green colour, and the regions corresponding to high flow
accumulation are depicted in yellow and red colours in Figure 7. The accumulation of
flow was found to be highest (reaching to a value of 1.299eþ 06) along the streamlines
near the channels and lowest in the rest of the watershed of the research region, as seen in
Figure 7.

The slope (degree) map of Afghanistan was generated from the DEM raster file
utilizing the spatial analyst tool in ArcGIS 10.7.1 platform, as seen in Figure 8.
Finally, the maps of flow accumulation and slope were combined to generate the LS
map using the methodology in the raster calculator of the ArcGIS
environment> Spatial Analyst tool.

Using the flow accumulation, slope steepness, and size of cell generated from the
DEM raster file, as explained in the flowchart in Figure 6, Equation (9), as proposed
by Moore and Burch (1986), was used to calculate the LS factor on the ArcGIS plat-
form, as follows:

LS ¼ Flow�accumulation � cell�size
22:13

� �0:4

� sin� slope degreeð Þ � 0:01745
0:0896

� �1:3

(9)

where LS is the slope length gradient factor. The flow-accumulation represents the
accumulated up-slope contribution catchment region for a specific cell, the cell-size
represents the size of the grid cell (for this research, 250m spatial resolution), and
sin-slope denotes the angle of slope in degrees.

Equation (9) is also employed in the literature, such as by Prasannakumar et al.
(2011), Mahalingam et al. (2015), Baby and Nair (2016), and Markose and Jayappa
(2016) for the Siruvani river watersheds in the Attapady valley, Kerala; Pandavapura,
Mandya, Karnataka; Kuttiyadi river basin, Northern Kerala; and Kali river basin,
Karnataka, respectively. Pal and Shit (2017) studied soil erosion in Jaipanda watershed
in West Bengal while Pal and Chakrabortty (2019a) investigated soil estimation in
sub-tropical Arkosa watershed in eastern India. All researchers above have assumed
m¼ 0.4 and n¼ 1.3, according to Moore and Burch (1986).

3.4. Application of RUSLE for estimation of soil erosion in the Upper-Helmand
River Basin

The RUSLE components (R, K, LS, C, and P) have been incorporated into the GIS
platform to estimate the average annual soil erosion. The linear equation
(R�K� LS�C�P) has been considered for generating the soil erosion raster map
while considering the pixel information of each component (Renard et al. 1997;
Chakrabortty et al. 2022; Pal et al. 2021).

GEOMATICS, NATURAL HAZARDS AND RISK 13



4. LS factor results

The findings from assessing the three LS-factor models for the entire Afghanistan
watersheds are presented herein.

4.1. Topographic factor (LS) results by Method 1

The calculated LS factors for Afghanistan, presented in Figure 9, range from 0.01 to
44.31, with a mean of 5.24 and a standard deviation of 6.957. According to Figure 9,
the regions with low LS values are primarily located in the southwest, west, and
northern parts of Afghanistan, near the borders of Turkmenistan and Uzbekistan
while large LS values are found to be located in the northeast, north, and central
parts of Afghanistan, which is consistent with its high mountains and deep valley
geomorphology. These results imply that northeast, north, and central parts of
Afghanistan are particularly prone to soil erosion by runoff water.

4.2. Topographic factor (LS) results by Method 2

Figure 10 presents the LS factor map generated by employing Method 2. The LS-fac-
tors are ranging between 0.03 and 163.49, with a mean of 9.6 and a standard devi-
ation of 13.58. As seen in Figure 10, high LS-factors are found to be in regions with
steep slopes near rivers and streamlines. This indicates that the combination of L and
S factors significantly influences soil loss in the northeast, north, and central regions

Figure 9. Map of the LS factor in Afghanistan, generated using Method 1.
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Figure 10. Map of LS factor in Afghanistan, generated by Method 2.

Figure 11. LS factor map in Afghanistan, calculated by Method 3.
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of Afghanistan. Method 2 also produced low and high LS-factor values at almost the
same regions, as in Method 1.

4.3. Topographic factor (LS) results by Method 3

Figure 11 presents the LS factor map generated by Method 3. The LS-factors for the
entire Afghanistan range between 0 and 3985, with an average value of 7.16 (Figure 11).
Maximum value of the LS-factor is found to be significantly high at irregular topog-
raphy where more flow accumulates (see Figure 7) near or along the streamlines, contri-
buting to increasing the LS factor. Low LS factor values are found in the southwest,
west, and northern parts (near the borders of Turkmenistan and Uzbekistan) of
Afghanistan. High values of the LS-factor are seen in the northeast, north, and central
parts of Afghanistan, which is consistent with its high mountains and deep valley geo-
morphology (see Figure 3). These locations (northeast, north, and central parts of
Afghanistan) are especially prone to erosion by water due to the steep slope gradient
(see Figure 8).

4.4. Annual soil loss estimation for Upper-Helmand River Basin

The primary goal of this analysis is to assess the LS factors generated by three differ-
ent methods. In addition, it is desired to assess how the estimated LS factors by each
method can produce sediment delivery ratio (SDR). This is presented by applying the
RUSLE to Upper Helmand River Basin.

4.4.1. Helmand River Basin
The HRB covers about 50% of the Afghanistan landmass including 14 provinces
(AIMS-FAO 2004; Goes et al. 2013). The HRB is the vital source of flowing water

Figure 12. Location of Upper-Helmand river basin catchment in Afghanistan.
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into the Kajaki dam, which is a significant resource for domestic water supply in an
indirect way by recharging the shallow aquifers along the river and also used exten-
sively for irrigation network (AIMS-FAO 2004; Goes et al. 2013). The basin has long
been recognized as Afghanistan’s breadbasket and has the potential for agricultural-
based industries, particularly high-value horticulture (Goes et al. 2013). The Upper-
HRB is a sub-watershed of the HRB (see Figure 12), covering an area of
46,881.97 km2 (about 7% of Afghanistan), and the catchment is a vital water supply
resource for irrigation of agricultural lands and hydropower production. The Upper
HRB is considered in Section 4.4 because of the existence of Kajaki Dam, which is
subjected to the extensive sedimentation problem. The dam is vital for Afghanistan
for both irrigation and power purposes.

The revised universal soil loss equation (RUSLE) (Equation (10)) was used to esti-
mate the soil erosion (Renard et al. (1997):

A ¼ R � K� L� S� C� P (10)

where average annual soil erosion potential A (ton ha�1 year�1) is computed by mul-
tiplying the developed raster data from each RUSLE analysis. R is the rainfall–runoff
erosivity factor (MJ mm ha�1 h�1 year�1); K is the soil erodibility factor (ton ha h
ha�1MJ�1mm�1), L and S are topographic factors that vary with slope length and
gradient (dimensionless), C is the crop and crop management factor (dimensionless),
and P is the soil conservation practice factor (dimensionless, and ranges from zero
to one).

The SDR represents the ratio of sediment yield to gross soil erosion (Maner 1958;
De Vente et al. 2007). The SDR was calculated by dividing the average annual sedi-
ment yield by the gross soil loss, predicted by the RUSLE, as shown in Equation (11).

SDR %ð Þ ¼ SY
ARUSLE

� �
� 100 (11)

where SY stands for the annual average sediment yield in t year�1; SDR stands for
sediment delivery ratio, dimensionless scalar; and ARUSLE is the average annual soil
loss determined by the RUSLE erosion model in ton year�1. The five major RUSLE
factors (R, K, LS, C, and P) were combined using the raster calculator in the ArcGIS
spatial analyst tool to quantify the annual average soil loss (ARUSLE) from the Upper-
Helmand River Catchment.

Average annual soil loss was estimated based on five potential data layers of
RUSLE (R, K, (LS-Method 1, LS-Method 2, and LS-Method 3), C, and P)) using the
raster calculator of the Spatial Analyst tool extension in the ArcGIS 10.7.1 environ-
ment. The findings demonstrate that the annual soil loss of the Upper-Helmand
River Basin (Figure 13(a)) ranged from 0 to 131.2 by using the LS-factor of Method 1
(see Figure 13(b)) and 0 to 242.3 by using the LS-factor of Method 2 (see Figure
13(c)) and 0 to 2877.1 by using the LS-factor of Method 3 (see Figure 13(d)) in the
RULSE equation, with mean annual soil loss of 9.3, 18.2, and 11.1 ton/ha/year.

The average annual sediment yield rate of the Kajaki reservoir, located on
Helmand River was obtained from the US Army Corps of Engineers (2012) survey
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report. According to their survey report, the average annual (trapped/settled) sedi-
ment yield rate in the active pool of the Kajaki reservoir is 8.53M-m3/year. Using the
mean annual sediment yield of the Kajaki reservoir and mean annual soil loss rates,
the SDR of the Upper-Helmand River Basin was determined by Equation (11) and
the results are summarized in Table 2.

The average annual soil loss in Upper-Helmand River basin is 9.3, 18.2, and 11.1
(ton/ha/year) by applying the three different LS-factor values in RUSLE equation,
respectively, and resulting SDR values are 23.48%, 12.02%, and 19.85%, that are com-
patible with the findings of Arekhi et al. (2012), Bagherzadeh et al. (2013), and
Nikkami and Shadfar (2021) who estimated the average SDR of 23%, 24.8%, and
25.22% for the watersheds which has similar land characteristics and topography.

The study revealed that the LS-factor has a close agreement with soil loss rate and
SDR. Increases in the LS-factor lead to an increase in runoff water-driving power,

Figure 13. (a) Upper-Helmand River Basin Elevation, (b) Soil erosion map by Method 1, (c) Soil ero-
sion map by Method 2, and (d) Soil erosion map by Method 3.

Table 2. Average LS-factor values, average annual soil loss, and SDR.

Average LS factor value (Method 1, Method 2, and Method 3)
Average annual soil loss
(RUSLE) (ton/ha/year) Sediment delivery ratio (%)

Method 1 5.24 9.3 23.48
Method 2 9.60 18.2 12.02
Method 3 7.16 11.1 19.85
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which in turn leads to an increase in soil loss. From Table 2, it can be seen that the
soil loss increases with increasing the LS-factor, while SDR decreases.

4.5. Discussion of results

Three approaches were employed in this study to calculate the LS-factor for the entire
Afghanistan. The LS results of the three methods ranged from 0.01 to 44.31 according
to Method 1, from 0.03 to 163.49 according to Method 2, and from 0 to 3985 accord-
ing to Method 3, with respective means of 5.24, 9.6, and 7.16 and standard deviations
of 6.95, and 13.58, and 29.70.

The validation of the results was difficult due to a lack of local data, a common
problem in developing countries, especially in a war-torn Afghanistan. As an alterna-
tive, the consistency of the results of this study was compared against those of previ-
ous studies having used similar techniques and objectives in regions with similar land
characteristics and topography (Sujatha and Sridhar 2018). Iran, Turkey, some parts
of China, and India have almost the same topography and follow the same seasonal
patterns; therefore, in this study, the findings were compared against those related to
these countries. The estimated mean LS-factor results (5.24, 9.6, and 7.16) of the
study agreed with the findings of Mohammadi et al. (2021), who calculated the mean
topographic factor value of �4 for all watersheds in Iran. Panagos et al. (2015) also
found the mean LS factor of 5.2 for the whole Austria, which is consistent with the
result of this study. Jobin Thomas et al. (2018) estimated mean LS value of �8 in the
southern Western Ghats, India.

In addition, according to the entire India LS factor map prepared by Pal et al.
(2021), the LS factor in the mountainous regions located in Srinagar, Gilgit-Baltistan,
and Ladakh of India is in the same increasing trend as our results obtained in the
mountainous areas of Afghanistan.

The location of Afghanistan is in the greater Alpine-Himalayan Orogenic Belt in
Asia (Shroder 2014). In north Italy, the Alpine basin with steep mountainous topog-
raphy and high elevation Kaffas et al. (2021) calculated mean LS factor of �8.8 using
the equations of (Desmet and Govers 1996) and (McCool et al. 1989). The spatial
pattern of the LS factor is consistent with that estimated by Yang (2014), Yang et al.
(2018), Sujatha and Sridhar (2018); Chakrabortty et al. (2020), who have demon-
strated LS values increase in mountainous regions and lower in flat plains. Compared
to these studies, the calculated LS value and the spatial distribution are generally
reasonable.

The comparable mean values (5.24, 9.6, and 7.16), estimated by the three methods
imply that these methods can be employed for estimating LS factors. All the three
methods, although the magnitude has a wide variation, produced maps having low LS
factor values in the southwest, west, and northern parts and high LS values in the
northeast, north, and central parts of Afghanistan. These results imply that the north-
east, north, and central parts of Afghanistan might be particularly prone to soil ero-
sion. Mohammadi et al. (2021) have spotted high LS factor values in the
mountainous regions of Iran and revealed the effect of slope steepness on soil erosion
that agree with the findings in this study. They found the highest soil loss values in
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the steep slopes of the Alborz and Zagros mountains, located in the north, west, and
southwest parts of Iran.

The results showed that increasing LS-factor values increases soil loss that corre-
sponds to with the findings of Renard et al. (1997). Increasing of the LS parameters
increases velocity of water on the ground surface and finally, giving rise to higher soil
loss values (Wischmeier and Smith 1978; Gupta and Kumar 2017; Ghosal and Das
Bhattacharya 2020; Pal et al. 2021). Soil erosion is a significant concern, particularly
in the research area, where several causes contribute to the fast erosion and sedimen-
tation of soil. Factors, such as the steepness of the slope of the study area, higher
overland runoff velocity on steeper slopes, and environmental variables all enhance
the soil erosion and sedimentation rate. Kaffas et al. (2021) and Chakrabortty et al.
(2022) have demonstrated that the steepness of the slope and greater overland runoff
velocity on steeper slopes lead to a higher gravity and produce more increment in
soil erosion. This result is compatible with that of Negese et al. (2021), who reported
severe soil erosion in the steep and very steep slopes of Chereti Watershed in
Northeastern Ethiopia. Das et al. (2022) and Negese et al. (2021) have concluded that
the soil erosion and LS-factor increase as the accumulation of flow and slope
increases across the catchment area. Hui et al. (2010) conducted a study in Liao
Watershed in Jiangxi Province of China; they also found that the LS-factor values are
high in the mountainous regions with no vegetation cover and steep topography. All
these results may conform to the reliability of the findings in this study.

The result shows that the equation of Moore and Burch (1986), used in Method 3,
significantly overestimated the maximum value for the LS factor and gave a

Figure 14. Accuracy comparison of the three methods for calculation of LS-factor; (a) Hillshad
map, (b) Method 1, (c) Method 2, and (d) Method 3.
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considerably higher LS value, compared to the maximum values of Methods 1 and 2.
The first reason for such a large discrepancy might be that Method 3 considers flow
accumulation as a significant input and thus large LS factor values are only computed
close to or at the streamlines located near to mountainous regions.

The graphical comparison of the three methods was performed for the LS-factor,
using a 250m resolution DEM covering the entire Afghanistan river basins. Based on
the hillshade map shown in Figure 14(a), which is a segment of study area, it was
observed from the graphical comparison among the three methods that Method 1, as
seen in Figure 14(b), is more apparent and shows clearer distribution LS-factor values
over the catchment segment compared to the other methods and it gives an unam-
biguous indication of the LS of the research area. The reason might be that the mul-
tiple flow algorithm (MFD) used in LS-TOOL can adapt to convergent and divergent
overland flow and work more effectively than single-flow direction (SFD) algorithms
for watersheds. That is how the LS-TOOLMFD can produce a better LS-factor map.
Method 2, as shown in Figure 14(c), also presents a clear distribution of LS-factor
over the region because, while calculating, the slope-length was fixed to 22.13m in
order to prevent exceedingly long hill-slope length; that can have an impact on and
explain the geographical distribution of soil erosion throughout the watershed.
Method 3, as shown in Figure 14(d), on the other hand, showed a poor picture of the
LS-factor map compared to the LS-factor maps generated by Methods 1 and 2. This
fact is also seen in the LS-factor map calculated using the Moore and Burch (1986)
equation for sub-catchment regions of Juari River in Tripuara by Das et al. (2022).
However, it should be noted that comparison is based on the graphical assessment,
while the numerical values (mean and standard deviation) of the LS-factor calculated
using the mentioned three methods showed the best results for the entire
Afghanistan.

4.6. Sedimentation

About 0.5–1% of the sedimentation worldwide disrupts the annual loss of reservoir
storage capacity. In addition, it is estimated that by the year 2050, most of the world’s
dams would retain just half of their current capacity, which is quite alarming (Dams
2000; Chuenchum et al. 2019). According to Walling (2011), sediments presently
cover 40% of Asia’s reservoir storage, suggesting a significant loss of storage capacity.
These factors have an impact on the long-term sustainability of water resources
(Chuenchum et al. 2019).

The watersheds in Afghanistan do not have sediment gauging network for meas-
urement of sediment transported by runoff water. Therefore, this study’s findings are
comparable to those of similar studies in other parts of the world, particularly in
neighbouring countries where similar geo-climatological and topographic constraints
are prevalent (Fl€ugel et al. 2003; Lu et al. 2004), which validate the scalability of the
suggested models and methods.

Despite the fact that erosion is a serious concern in Afghanistan, there is no ero-
sion and sedimentation mapping for all basins. Most of the data on sedimentation
currently accessible comes from studies of sediment yield survey conducted from
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1953 to 1968 and from 1968 to 2010 after the construction of the Kajaki reservoir on
the Helmand River in southern Afghanistan.

Helmand River Basin (Upper, Middle, and Lower), which covers about 50% of the
Afghanistan landmass, is selected as a representative watershed for sedimentation and
the SDR study. According to Perkins and Culbertson (1970) and US Army Corps
(2014) survey conducted in Kajaki reservoir, the sedimentation occupies 42% of total
storage capacity of Kajaki reservoir, which is consistent with findings of Walling
(2011) for Asian reservoirs. Based on their results, average annual fill rate of Kajaki
reservoir is 8.53M-m3/year from 1953 to 2010. The estimated SDR of this study was
found to be relatively consistent with the mean SDR of Arekhi et al. (2012),
Bagherzadeh et al. (2013), and Nikkami and Shadfar (2021) who estimated the aver-
age SDR for the watersheds which has similar land characteristics and topography. In
comparison to these studies, the computed SDR value is reasonable.

Considering the importance of soil erosion, sedimentation, and the delivery ratio
of the watershed as an environmental issue in Afghanistan and the world (Shrestha
2007; Shroder 2014; Sujatha and Sridhar 2019), it is essential to model and identify
the effects of potential erosion zones and land use on land degradation, as it helps
sustainable planning and management of the watershed.

5. Conclusions

This study estimated, for the first time in the literature, the LS factors and produced
the related maps for the entire Afghanistan using three different methods. The aver-
age LS-factor values estimated in the studied area ranged 5.24, 9.6, and 7.16 with a
range of 0.01–44.31, 0.03–163.49, and 0–3985, respectively, for Methods 1–3. In this
study, the performance of the methods was evaluated by comparing the results with
the studies conducted in the regions that have the similar land characteristics or with
the neighbouring countries that have approximately similar topography.

All the three methods, although the magnitude has a wide variation, produced
maps having low LS factor values in the southwest, west, and northern parts and
high LS values in the northeast, north, and central parts of Afghanistan. These results
imply that the northeast, north, and central parts of Afghanistan might be particularly
prone to soil erosion.

The result shows that the equation of Moore and Burch (1986), used in Method 3,
significantly overestimated the maximum value for the LS factor and gave a consider-
ably higher LS value, compared to the maximum values of Methods 1 and 2. The first
reason for such a large discrepancy might be that Method 3 considers flow accumula-
tion as a significant input and thus large LS factor values are only computed close to
or at the streamlines located near to mountainous regions.

The SDR results also reveal that the RUSLE employing the LS factors produced by
the Method 1 have more compatibility with the findings in the literature for the
watersheds which have similar land characteristics and topography.

Concerning the erosion management strategies to minimize soil loss rate, the inter-
vention may concentrate on the LS-factor; hence, terrace management may reduce
the length of the slope and, as a result, control the soil loss. The combined use of LS
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with ArcGIS software and remote sensing technologies may be noticed to be crucial,
effective, and less expensive for the estimation and mapping of topographic factors,
as well as the identification of vulnerable catchment areas for conservation planning
and implementation objectives.

In general, one of the important limitations in studies for aiming at mapping topo-
graphic factors is the lack of validation data. This is particularly true for Afghanistan.
Although the produced LS factor values are reliable, they have not been yet validated
against the field measurements. Such a validation would update and enhance the LS
factor digital map for Afghanistan. The availability of high-resolution DEMs and the
continuous development of new algorithms and tools would provide possibilities for
overcoming the drawbacks of the current approaches and enhancing the accuracy and
resolution of the LS factor mapping.

The DEM and the GIS are used together in this study for the first time to estimate
the topographic factors for the entire watersheds of Afghanistan, which rectifies the
uniqueness of the work. The resultant LS map can be used as one of the multiplying
parameters in the RUSLE model for estimating the soil loss for various watersheds in
Afghanistan, as presented in this study, for the Upper Helmand river Basin. In add-
ition, this study would be important for national decision-makers to prioritize invest-
ment in treating land degradation in Afghanistan.

This study is not able to carry out the actual field-data comparison due to the cur-
rent situation in Afghanistan, that makes it practically impossible to accomplish this
mission. However, this study is aware of the importance of this matter, and therefore
it intends to complete this mission as soon as it is possible.
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